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1 General

1.1 Overview
This documentation describes the installation of the MTC200 and
TRANS200 control systems. The following individual components are
described.
• Language Switch
• System Configurator
• Data Backup

1.2 Language Switch
This chapter describes how the language in use can be changed.

1.3 System Configurator
The System Configurator is an editor that is used to describe and
configure the devices connected to the Control PC. The device address,
the device type and the description of the communication path to the unit
can be configured. This creates a 1:1 image of the device structure
(known as the system configuration) that is connected to the controller PC
and determines the form of communication between the user interface
and the devices connected.

1.4 Data Backup
Backup of program, user and configuration data is an important
component of an EDP system. The MTC200/TRANS200 system provides
multiple backup levels with differing data capacities. In addition, complete
backups can be made using external programs.
This documentation describes the execution of a data backup at the
workstations of a MTC200/TRANS200 system unit.
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2 Switching Language

2.1 Procedure
The language in use is changed by modifying an entry in the
"Language.ini" file.

Note: The Rexroth Indramat user interface must be exited before
making any changes. Changes take effect on the next restart
of the user interface.

The "Language.ini" file can be found in the Rexroth Indramat user
interface path in the directory "..\MTGUI\Config”. The file can be directly
edited with a Unicode-capable text editor (e.g. Notepad).
In the "General” section, the entry "ActLanguage = XX” must be edited,
where XX stands for the corresponding language identification.

[General]
ActLanguage=DE
DefaultLanguage=EN

Language identification corresponds to the DIN/INN standards.

Language Language Identification
German DE

English EN

French FR

Fig. 2-1: Language identification corresponding to DIN/INN standards.

Extract from Language.ini file:

Language identification
corresponding to DIN/INN

standards.
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3 Overview of System Configurator

3.1 Field of application
The System Configurator is an editor which is used to describe the de-
vices connected to the Control PC. The device address, the device type
and the description of the communication path to the unit are employed
for this purpose. The goal is to create an 1:1 image of the unit structure
(known as the system configuration) that is connected to the control PC.
The system configuration is stored in the control PC.
The System Configurator is used by the Function Interface and the User
Interface (MTGUI) for the organization of communication with devices
connected to the Control PC.

3.2 Menu Structure and Data Input
The left-hand half of the screen shows a graphical representation of the
configured units in a tree diagram. For the device selected in the tree, the
corresponding data is displayed on the right-hand side of the screen.

When entering data, for example when creating a new device or when
editing an existing device, the user is guided by an Assistant. The
Assistant splits the data entry into several steps.

SystemConfiguration.bmp

Fig. 3-1: System Configurator with two devices

Menu structure

Data input
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3.3 Installation and Start of the System Configurator
The System Configurator is installed when installing the MTGUI. The
System Configurator is started automatically after the installation.

Note: The System Configurator is an independent program and must
be started at least once before starting the MTGUI. The
System Configurator and the user interface cannot be simul-
taneously active. The System Configurator must be exited be-
fore starting the MTGUI.

The set-up program creates a link to the System Configurator on the
Desktop. Simultaneously, a link is added in the Rexroth Indramat program
path in the start menu. In both cases, the System Configurator is started
directly by the Syscon.exe program call.

3.4 Example scenario

If, for example, for an MTC200-R-G2, address 0 is selected at the
selector switch, and is connected via RS232 to COM2 of the Control PC,
the configuration must be entered in the System Configurator, i.e. a
device of type MTC200-R-G2, with device address 0, with a com-
munication address that includes the settings RS232 and COM2, etc..

If the physical configuration of a device is changed, the device must be
adjusted or edited in the System Configurator. If, for example, the con-
nection of device 0 to the Control PC is modified from COM2 to COM1,
device 0 must be edited in the System Configurator. This means that
COM1 has to be selected instead of COM2 as the channel in the corre-
sponding communication address.

Connecting a new device

Changing an existing device
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4 Information about the System Configurator

4.1 Device type
The device types available in this specific installation of the System
Configurator are shown in the “Device Type” selection list in the first step
of the “New Device” function (see Create New Device, Step 1).
The following list shows device types which are available depending on
the installation.

Device type Class Description
MTVNC MTCX Virtual MTC
MTC200-P-G2 MWCX MTC with PLC PC variant
MTC200-R-G2 MWCX MTC with PLC RECO variant
MTA200-P-G2 MTAX MTA with WIN-PLC PC variant
ISP200-P-G2 MWSX Standalone WIN-PLC PC variant
ISP200-R-G2 MWSX Standalone WIN-PLC RECO variant
SYNAX200-P MSYX SYNAX as PC variant
SYNAX200-R MSYX SYNAX as RECO variant
SERCANS-A MSCX SCS-A card
SERCANS-P MSCX SCS-P card
TRA200-R MTRX TRANS200 as RECO variant
ECODRIVE03 MECX ECODRIVE03

Fig. 4-1: Device Types and Device Classes

4.2 Device / Device Address
A device is understood to mean, for example, control hardware or a drive
device.
The range of values for entering the device address is 0 to 63.

4.3 Checking Free Serial Ports
A check of the free serial ports is performed. Serial ports already in use
(e.g. mouse) are not offered when editing communication addresses in
the System Configurator.
The check can be disabled (Menu Options, Entry Show only free COM
ports).
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4.4 Communication Address
The communication address is a Rexroth Indramat specific data set
which describes the communication path to the device. The communi-
cation address has a symbolic identifier which consists of the fixed part
CommAddr and a number, e. g. CommAddr2. Up to 8 communication
addresses can be specified (CommAddr1 to CommAddr8).

Note: Devices which are connected to the same serial port have the
same communication address.

4.5 Updating the Directory Structure
When saving the system configuration data, an update of the directory
structure will be carried out if necessary. The update of the directories will
only be carried out if devices have been deleted or new devices have
been added.

4.6 File Menu
The File Menu contains the Save and Exit menu items.
The system configuration is saved. (refer to 4.5 Updating the Directory
Structure)

If changes have been made, you will be asked by a MSG-BOX whether to
save and exit or exit without saving.

4.7 Options Menu
Refer to 4 Information about the System Configurator

The server service required for interconnection is started the next time the
user interface is started.

The device interrogation cycle is activated or deactivated, i.e. the device
status (error status, device online, ...) is actively continuously checked.
It is furthermore possible to determine how often this interrogation is to be
carried out.

Save

Exit

List free ports

Network active

Device interrogation cycle
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5 System Configurator Functions

5.1 Overview

Menu choice.bmp

Fig. 5-1: Menu Edit

The functions can be called in the Edit menu with the menu items New
Device, Edit Device, Insert Device, Copy Device, Delete Device, Cut
Device, Shift Device Up, Shift Device Down or with the toolbar button
to which the command is assigned.

Note: The underlined words correspond to the function designations
in the Edit menu.

The command New Device has the effect that this new device will be
inserted before the device currently selected in the tree.
The content of the functions create New device, Edit device and Insert
device (refer to 3.2, 3.3 and 3.8) depends on the device type. The follow-
ing tables provide an overview of these functions.

Create New
Device

Devices except MTVNC MTVNC

Step 1 Select device type Select device type
Step 2 Select device address Select device address
Step 3 Enter device name and

device status
Enter device name and
device status

Step 4 Select component type 1/2 No selection
Step 5 Enter communication address Configuration of MTVNC

(start mode, memory size)
Fig. 5-2: Steps for “Create New Device”
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Edit Device Devices except MTVNC MTVNC
Step 1 Enter device name and

device status
Enter device name and
device status

Step 2 Select component type 1/2 No selection
Step 3 Enter communication address Configuration of MTVNC

(start mode, memory size)
Fig. 5-3: Steps for “Edit Device”

Insert Device Devices except MTVNC MTVNC
Step 1 Select device address Select device address
Step 2 Enter device name and

device status
Enter device name and
device status

Step 3 Select component type 1/2 No selection
Step 4 Enter communication address Configuration of MTVNC

(start mode, memory size)
Fig. 5-4: Steps for “Insert Device”

5.2 Create New Device

The function can be called in the Edit Menu, via the menu item New
Device or via the toolbar button New. The new device is inserted ahead
of the device currently marked in the tree.
When entering data the user is guided by an Assistant. The Assistant
splits the data entry into several steps. The creation of a new device is
finished using the button Ready in the last step.

Menu selection_new.bmp

Fig. 5-5: Menu selection New Device
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Create New Device, Step 1

The device type is selected in this step. The device type must correspond
to the connected control PC.

Note: The device type cannot be changed after it has been created.

Create New Device, Step 2

The device address is selected in this step.
If the device is connected to the control PC by a serial connection and has
a selector switch, the device address has to correspond to the partici-
pant’s address selected at the device by the selector switch.

Note: The device address must be unambiguous.
The device type cannot be changed after it has been created.

Create New Device, Step 3

The device name is entered and the device status given. The device
name may include up to 32 characters and should not include special
characters.

Note: Set the device status to ON if the device exists and is ready,
otherwise to OFF.

Create New Device, Step 4

The component type is selected in this step. The selection list of
permissible combinations can be opened with the ALT + ↓ keys.

Create New Device, Step 5

A communication address is assigned to the device. A communication
address must first be selected in the Comm. Address selection list.
In the selection list, only communication addresses are offered that
correspond to the device type of the device being currently edited and that
have not yet been used by other devices. Devices connected by a serial
port are an exception. Please see also the note below.
If no communication address yet exists, it must be created by using the
New entry in the selection list or via the New toolbar button.
The communication address data depends on the device type and is
displayed in the corresponding entry fields. The data must correspond to
the device settings.

Devices except MTVNC
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⇒ For further information on devices, please refer to the technical
documentation for the device.

Note: If devices are connected to the control PC by a serial
connection, several devices may use the same communication
path (the same communication address), for example when
the RS485 protocol is used. The devices are addressed by the
participant’s device address selected by the selector switch.

Configuration of type MTVNC devices is performed in this step.

The start mode of the MTVNC can be changed via the selection list:
• ON: The MTVNC is started when starting the MUI/GUI.
• OFF: The MTVNC is not started.

Note: If device status is ON, the start mode of the MTVNC device is
automatically set to ON. The start mode of the MTVNC can
only be changed if the device status is set to OFF.

The amount of computer memory used by the MTVNC can be adjusted to
meet requirements:
• Default: 512KB
• Range of Values: from 256KB to 16383KB in 1 KB steps

The ”Options” entry can be accessed using the ”Extended” button. These
options are not needed for normal use.

Note: For the “Options” entry, data may only be entered following
agreement with Rexroth Indramat personnel. In normal
operation, no data is entered.

MTVNC
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5.3 Edit Device
The device to be edited must be selected in the 'System Configuration'
tree.
Editing of the device can be initiated by means of <Enter> or double-
clicking on the selected device, or via the Edit Device entry in the Edit
Menu as well as via the Edit Device toolbar button.

Menu selection_edit.bmp

Fig. 5-6: Edit menu selection

When editing data, the user is guided by an Assistant. The Assistant splits
the data entry into several steps. The Edit Device function will be finished
using the Finish button in the last step.

Note: Both the device address and the device type cannot be
changed.

Edit device, Step 1
The device name is entered and the device status given. The device
name may include up to 32 characters and should not include special
characters.

Note: Set the device status to ON if the device exists and is ready,
otherwise to OFF.

Edit device, Step 2
The component type is selected in this step. The selection list of
permissible combinations can be opened with the ALT + ↓ keys.
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Edit device, Step 3
The communication address data can be changed and a new communi-
cation address created. Furthermore, the communication address cur-
rently assigned to a device can be changed.
The communication address selected in the Comm. Address selection
list is assigned to the device.
In the selection list, only communication addresses are offered that
correspond to the device type of the device being currently edited and that
have not yet been used by other devices. Devices connected by a serial
port are an exception. Please see also the note below.
The communication address data depends on the device type and is
displayed in the corresponding entry fields. This data must correspond to
the device settings. For further information on devices, please refer to the
technical documentation for the device.

Note: If devices are connected to the control PC by a serial
connection, several devices may use the same communication
path (the same communication address), for example when
the RS485 protocol is used. The devices are addressed by the
participant’s device address selected by the selector switch.

Configuration of type MTVNC devices is performed in this step.

The start mode of the MTVNC can be changed via the selection list:
• ON: The MTVNC is started when starting the MUI/GUI.
• OFF: The MTVNC is not started.

Note: If device status is ON, the start mode of the MTVNC device is
automatically set to ON. The start mode of the MTVNC can
only be changed if the device status is set to OFF.

The amount of computer memory used by the MTVNC can be adjusted to
meet requirements:
• Default: 512KB
• Range of Values: from 256KB to 16383KB in 1 KB steps

With the button ”Extended”, the ”Options” can be accessed. These
options are not needed for normal use.

Note: For the “Options” entry, data may only be entered following
agreement with Rexroth Indramat personnel. In normal
operation, no data is entered.

Devices except MTVNC

MTVNC
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5.4 Delete Device
The device to be deleted must be selected in the 'System Configuration'
tree.
The selected device is deleted via the Delete entry in the Edit menu, or
via the Delete toolbar button, as well as via the <Del> keyboard key. A
security prompt then appears.

Note: By deleting a device, the data in this device’s directory is also
deleted.

5.5 Cut Devices
The device which is to be cut must be selected in the 'System Configur-
ation' tree.
The selected device is deleted and copied into a temporary buffer via the
Cut entry in the Edit menu or via the Cut toolbar button. A security
prompt then appears.
For inserting the device, refer to 5.7 Insert Device.

5.6 Copy Device
The device to be copied must be selected in the 'System Configuration'
tree.
The selected device is copied into a temporary buffer via the Copy
Device entry in the Edit menu or via the Copy toolbar button.
For inserting the device, refer to 5.7 Insert Device.

5.7 Insert Device
If a device is saved in the temporary buffer, it can be inserted via the
Paste Device function. The device will be inserted ahead of the device
currently selected in the 'System Configuration' tree.
The user must enter a device address when the device is inserted. If
necessary, further settings may be changed. The user is guided through
this process by an Assistant. The following general procedure is valid:
• The device address must be assigned as in Step 1 (refer to 'Create

New Device').
From Step 2 on, the steps as for the Edit Device function are gone
through.
• In Step 2 of Insert Device, the device name and the device status are

set.
• In Step 3 of Insert Device, component type 1/2 is chosen.
• In Step 4 of Insert Device, the communication address is edited or the

MTVNC configured.

Note: Copy / Cut / Insert includes the device’s system configuration
data (device type etc.). It does not include data such as NC pro-
grams, message texts, etc., located in the device directories.
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5.8 Move Device Upwards
The device to be shifted must be selected in the 'System Configuration'
tree.
The selected device is shifted one entry up in the tree via the Shift
Device Up entry in the Edit menu or via the Shift Device Up toolbar
button.

5.9 Move Device Downwards
The device to be shifted must be selected in the 'System Configuration'
tree.
The selected device is shifted one entry down in the tree via the Shift
Device Down entry in the Edit menu or via the Shift Device Down
toolbar button.
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6 Data Backup - Introduction

6.1 Chapter Overview
This chapter gives you an overview of the data structure, the backup
mechanisms and the data organization of the MTC200/ISP200 control
family.

6.2 Purpose of this Documentation
This documentation describes how to carry out a data backup at the work-
stations of an MTC200/ISP200 system unit. Both single-seat systems and
networked systems are considered. The data backup (complete backup)
is described with the help of three programs currently available on the
market and used by Rexroth Indramat.

6.3 Determine Hardware and Software Configuration
Due to the variety of possible hardware components in use (MO drive,
network card), this manual only considers one specific configuration.
Nevertheless the data backup can also be carried out with other suitable
programs and mass storage. However, only one of the configurations
tested by Rexroth Indramat is described in this documentation. This de-
scription refers to the following hardware and software components.

Hardware
BTV20, BTV30

SMC 9000, typically found in the BTV20/30
Fujitsu M 2513 Parallel MO drive

Software
MS-DOS
Ghost 5.1d from Symantec
HDCOPY 2.0 Pro from HDTRONIC
DriveImage Pro 3.0 from PowerQuest

Operation and Visualization
Terminal

Network card
External mass storage

Operating system
Data backup software
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6.4 Purpose of Data Backup
EDP systems are not static systems. Data is continuously created,
modified, moved or deleted. Components are added or removed, updates
are carried out, settings are modified. Furthermore, both user and system
data must be taken into account. There are many reasons for carrying out
a data backup:
• Saving of data in case of a hardware failure
• Restoring the system environment after incorrect operation
• Saving main system settings
• Archiving a system state before carrying out an update
• Providing an identical system environment

The MTC200/ISP200 system provides multiple backup possibilities, each
with a different quantity of data.

6.5 Data Structure
The MTC200/ISP200 system data can be divided into three groups.
WindowsNT operating system data. These include system files, network
files, service pack files, files with settings such as the registry, etc.
The Rexroth Indramat user interface files include the user interface,
language files and configuration files with settings.
User data includes both preparation data on hard disk and data that is
loaded in the controller or the drives.

User data

Hard disk data
(e.g. NC programs/SPS programs, machine parameter,
NC variable list, tool data, ...)

Unchanging
control data
(e.g. NC programs)

Changing
control data
(e.g. NC variables)Production

Preparation

User interface, language files, presettings, ...

Operating system Windows NT, service packs,
settings, ...

Operating
System

Indramat User
Interface

1DatStruc.FH7

Fig. 6-1: Data structure

Operating system

Rexroth Indramat user interface

User data
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6.6 Backup Mechanisms
For the backup and/or the restore of the different data areas, various
backup mechanisms are available.
After a system crash the operating system can be re-installed using the
WindowsNT CD. WindowsNT must be again configured afterwards. The
configuration settings can only be restored if they have been completely
saved  beforehand.
The Rexroth Indramat user interface can be re-installed after a system
crash using the installation CD or the diskettes. The settings can only be
restored if they have been completely saved  beforehand.
User data is saved on an external data storage medium (server, MO,
diskettes) by the Rexroth Indramat data backup program. It is possible to
restore the data after a system crash.
The complete backup is the most comprehensive backup method. It in-
cludes all data areas. During complete backup using an external program,
the complete data area of a hard disk (complete hard disk or single parti-
tions) is written in an image file. Besides user data, the operating system
and the Rexroth Indramat programs, including all settings, are also saved.
This complete backup is the only way of restoring an identical system en-
vironment after a hardware failure.

6.7 Which Data Should Be Saved?
User data loaded in the controller (e.g. NC programs, NC variables etc.)
should be saved.
Further user data can be found on the hard disk, e. g. NC programs/PLC
programs, machine parameters, tool data, NC variable lists and configur-
ation files, etc.
These are control interface program and language files.

These include WindowsNT interface program and configuration files, the
network environment, and service packs.

6.8 When Should Data Be Backed Up or Restored?

User data
• for archiving after the project is completed
• after setup
• before testing
• before carrying out software and firmware updates
• cyclically at fixed time intervals
• after an incorrect software and firmware update
• after incorrect operation
• after replacing PLC, NC or drives containing firmware
• after replacing a hard disk containing pre-installed software

Operating system

Rexroth Indramat user interface

User data

Complete backup

User data

User interface data

Operating system data

Backup

Restore
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Complete backup
• cyclically at fixed time intervals
• before replacing hardware, e. g. installation of a larger hard disk
• after handing over to the customer

• after a hard disk failure
• after a complete control system crash
• for duplication of a control system

Note: Please take the operating system and the Rexroth Indramat
software licensing agreement into account when a hard disk or
a partition is duplicated.

6.9 Where Should I Backup?

Diskette
• Suitable for small amounts of data such as user data
• Easily handled
• Inexpensive data storage medium

Hard disk
• Large memory capacity
• Fast medium
• All stations of a transfer line can be saved centrally.

MO Drive
• Safe medium (40 years archiving period guaranteed)
• Can be re-written as often as desired
• No additional PC necessary for local data backup
• Large memory capacity (640 MB). About 450 MB is currently needed

for a complete(uncompressed) data backup.

Backup

Restore
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7 Backup Strategies

7.1 Chapter Overview
This chapter informs you which data is to be saved on which data storage
medium.
For data backup, the following procedures are available. Depending on
the amount of data, it can be saved on diskette, on MO connected to the
BTV or via Ethernet on a backup PC.

7.2 Backup on Local Data Storage Media
User data from the controller and the drives on the hard disk of the BTV is
saved on external data storage media by the data backup program de-
livered together with the software. Depending on the amount of data,
various types of data storage media can be used.
Diskette
MO drive (rewritable optical disk)

User data

MO-D
riv

e
Parallel port

BTV Diskette or MO drive
2Lok-MO-FD.FH7

Fig. 7-1: Local backup on diskette or MO drive

7.3 Backup over Ethernet on Master Controller BTV
For stations networked by Ethernet, individual station user data can be
saved on the master controller’s data storage media. Furthermore, the
image files of the complete backup can be transferred to the master
controller.
For data backup, an MO drive connected to the master controller is used.

Which data is saved?

What is the data saved on?

Which data is saved?

What is the data saved on?
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Image file
User data

User data

MO-D
riv

e
Parallel port

BTV 20
Master control

MO drive

BTV 20 BTV 20

Ethernet

Complete backup

2Net-kopf-MO.FH7

Fig. 7-2: Backup to master controller MO drive

7.4 Backup over Ethernet to Backup PC
As an alternative, a backup PC connected to the network can save the in-
dividual station user data and image files of the complete backup.
The hard disk of the PC can also be used for backup if it has enough disk
space. The use of an MO drive is also feasible, with each station having
its own medium.

Image file
user data

MO-Drive

Parallel port

BTV 20
Master station

MO drive

BTV 20 BTV 20 BTV 20

Ethernet

Backup PC

User data

Complete backup

2Net-PC.FH7

Fig. 7-3: Backup on backup PC hard disk or MO drive

Which data is saved?

What is the data saved on?
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8 Archiving User Data

8.1 Chapter Overview
This chapter describes how user data is archived (backup and restore)
with the help of the archiving program delivered with the controller.

8.2 Procedure
Data files on the hard disk are saved and can be restored as necessary
with the help of an archiving program. The files are compressed and
written to the data storage medium during the archiving process.
Diskettes, hard disks or MO drives can be used as media for archiving.

User data

RestoreBackup

Backup Load

 Disk, MO, portable PC,
 network drive, ...

 NC  SPS

 Drives

B
ac

ku
p

Devices/
Control

External
memory

P
re

pa
ra

tio
n

P
ro

du
ct

io
n

PC
hard disk

3Verfahr.FH7

Fig. 8-1: The archiving procedure

Data Not Included in Archiving
Not all of the total system data is saved with the archiving function.
Optional Rexroth Indramat systems such as Dolfi, Application Builder,
Screen Manager and WOP are not saved. In addition, external programs
such as the NC programming systems ARTIS, Fremd-WOP, etc., are not
saved. This data can only be saved by executing a complete backup.
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Preparation
Before beginning the backup, data that can be modified within the con-
troller (NC variables, NC events, D-corrections, tool lists, zero offset data,
machine data, residual PLC data, SERCOS parameters) must be saved
on the hard disk. This can be done via the corresponding menus or cen-
trally via the archive function (menu item 1 Archive) in the BOF.
The SERCOS parameters are not saved via menu item 1, Filing, but can
be saved in menu item 5, Edit Machine Parameters, under Drive Para-
meters. Residual PLC data must be saved using the block commands in
the PLC.

Backup
The backup consists of two steps. The data to be saved is defined in a
batch file. Firstly, all data to be saved is copied to a temporary directory
on the local hard disk. In addition to the temporary directory, the structure
file “archive.asl” is created. This structure file includes all necessary infor-
mation about the saved data (e. g. origin, date, etc.). Compression is first
done after ensuring that all files to be saved are available. The complete
temporary directory content is always compressed. The result of com-
pression is a ZIP file. A ZIP file which exceeds the size of the selected
storage medium is automatically split across multiple media. When com-
pression is finished, the temporary directory and all sub-directories are
deleted.

Create temporary directory
structure and files

Batch
file

Temp.
director. file

Compress

ZIP file

Structure

3Abl-Back.FH7

Fig. 8-2: Procedure for backing up user data

SERCOS parameters and
residual PLC data
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Restoring
From the selected archive file (ZIP file), the files are decompressed into a
temporary directory. The complete archive file contents are always de-
compressed. Single files cannot be restored. The files are copied to their
destination directories only after fault-free decompression of all files. The
temporary directory is deleted after the files have been successfully
copied.

Dest.
director.

Distribute to dest.
directories

Decompress in temporary
directory

ZIP file

Temp.
Director. file

Structure

3Abl-Rest.FH7

Fig. 8-3: Procedure for restoring user data

Restoring Data to the Controller
After the restore, data that can be modified (NC variables, NC events, D-
corrections, tool lists, zero offset data, machine data, residual PLC data,
SERCOS parameters) must be loaded back into the controller. This is
done in the corresponding menus.
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8.3 Selecting Data
The files to be saved are selected by means of batch files. This is done
so that the user does not have to select individual files. A range of pre-
defined batch files lets the user determine the extent of the backup.
Individual data types such as NC data can be selected, or individual de-
vices up to a complete backup of all devices. The data packets can be
selected via a list field.

3Dattyp.pcx

Fig. 8-4: Selection of data packets via a list field

8.4 Batch Files
In addition to the pre-defined batch files for the backup of individual data
types or devices there are two user-specific files. The user can create his
own backup selection via these user defined batch files. The batch files are
called “BACKUP_USER_IND_1.ASD” and “BACKUP_USER_IND_2.ASD”.
They are located in the <Drive>\...\Project_000\CustomData\Resource di-
rectory. ASD files are ASCII files and can be modified using an editor.

;BACKUP_USER_IND_1.asd
;
$AREA$\CONFIG\ /DIR /DEL
$AREA$\CONFIG\*.* /-

$AREA$\PROJECT_000\ /DIR /DEL
$AREA$\PROJECT_000\*.* /- /SUB

Fig. 8-5: The batch file “BACKUP_USER_IND_1.ASD”
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File Structure
The file consists of individual command lines in which the files/directories
to be saved are indicated.
<Path(logical path)><File><Space><Switches>
Example:

$AREA$\CONFIG\*.* /- /SUB

Rules
Path information must always be given as logical paths, no physical paths
must be used.
Logical path information is given at the beginning of the command line
and is enclosed by "$" characters.
File names can be indicated with wildcards (e. g. *.*, *.dat, ...).
Blank lines and comments are ignored.
Comments are introduced by a “;” character, the character may be po-
sitioned at the beginning of a comment line and at the end of a command
line.
Example:

; a comment line
$AREA$\Project_000\*.* /SUB ; comment within a command line

Switches
In addition to path and file information, it is also possible to add additional
information to the command line by means of switches.
Any subdirectories present are taken into account.
If a file is not present, it is ignored. An error message is displayed for any
other case.
The directory indicated in the command line is always created during the
restore process if it does not already exist. This is independent of
whether there are files in this directory or not. Files to be copied into this
directory must, in addition, be indicated in a separate command line.
This switch is either standalone or in connection with /DEL.
During restore, the directory is emptied; any existing files are deleted.
During restore, files having this switch are not overwritten by files from
the archive that have the same name.

Example of a batch file:

;Area Files
$Area$\*.* /SUB
;Drive
$Drive$\my_dir\myfile.dat

Syntax

Paths

File names
Comments

/SUB
/-

/DIR

/DEL
/EXC
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Areas
Physical path information is replaced by logical path information.
These are split as follows:
$Area$: replaces the installation directory, e.g. …\MTGUI
e.g. $Area$\*.* /SUB: backs up all files in the directory …\MTGUI in-
cluding any subdirectories present
$Drive$: replaces installation drive D:
e.g. $Drive$\my_texts\myfile.dat: backs up the file MYFILE.DAT in the
\MY_TEXTS subdirectory on the installation drive

8.5 Executing a Backup

Prerequisites
• The data to be saved must be hard disk data. User data from con-

troller and drives must therefore be saved to the hard disk before
backup.

• The backup program requires unlimited and exclusive access to the
files to be saved. It is therefore necessary that all active applications
(user interface, function interface, System Configurator) are terminated.

• Sufficient memory must be available on the drive (hard disk, MO drive)
to be archived. Furthermore, the program requires enough memory on
the hard disk for the temporary files archive of the data to be saved.
Several diskettes must be available when backing up to a diskette
drive. The diskettes do not have to be formatted. Formatting can be
carried out by the program if so desired.

• It is recommended that only tested, fault-free diskettes are used. Most
problems encountered when restoring are due to faulty diskettes.

Note: The archive diskettes must be clearly labeled, so that the
correct diskette is inserted when prompted.

⇒ Attach labels to a number of diskettes and number these sequentially.

Using the Backup Program
The backup is carried out with the help of an Assistant. This guarantees
easy handling. After selecting an option, pressing the Next button leads
to the subsequent dialog. The Back button leads to the previous dialog.
In the final dialog, archiving is started by pressing Execute, and the
previously-made settings are used.
Function key <F1> opens the help function at any time. The table of
contents points to the required topic. The various backup mechanisms
are described.

Area

Drive

Assistant

Online Help
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Saving Control Data on Hard Disk
Data that can be modified within the controller (NC variables, NC events,
D-corrections, tool lists, zero offset data, machine data, residual PLC
data, SERCOS parameters) must be saved on the hard disk before
executing the backup.

Calling the Backup Program
The backup program is called via the Windows start menu.
⇒ Open the backup program using the Start - Programs - Indramat -

Backup menu sequence
The program is loaded. A dialog window with a selection list of pre-
defined data packets is displayed.

Selecting data packets to be saved
This lists the possibilities currently available for data backup. The data
packets delivered by Rexroth Indramat at installation include
• Backup of all user data (complete backup: directory ...\Project_000\...)
• Backup of all HMI data (backup of HMI data: directory

...\Project_000\CustomData\..., as well as ...\Project_000\OemData\...)
• Two packets are reserved for users who only wish to backup special

directories: user-defined backup 1 & 2. The associated files
BACKUP_USER_IND_1.asd and BACKUP_USER_IND_2.asd can be
found in directory ...Project_000\CustomData\Resource. At installation
time, their contents represent a complete backup. These files can be
modified by the user.

3BackPaket_gr.bmp

Fig. 8-6: Selecting data packets to be saved

⇒ Select the data packet to be archived by marking it and pressing
Cont..
A dialog window for selection of the file archive is displayed.
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Entering the Destination File

3BackZiel_gr.bmp

Fig. 8-7: Selection dialog for destination file

There are three ways of selecting a destination file.
• Accept the proposed file name and drive enter a new file name and

drive. The proposed for file name corresponds to the data package
selected.

• The Archive list button opens a list of previously-created archives. It
offers an overview and the possibility to select an existing archive.
This archive is then overwritten.

• Create a new archive by opening a file selection window with the
Browse button and determine drive, folder and file name. A file name
for the archive file is also proposed here. It is also possible to save via
the network. During backup on a network drive, this drive is
connected.

⇒ Select one of the possibilities.
Independently of the possibility selected, an entry field for additional
file information is displayed.

Three ways of selecting an
archive
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Selecting an Existing Archive
The last archives, to a maximum of 8, are listed here. The user can select
one of these by clicking it. This existing archive is then overwritten.

3BackArchiv_gr.bmp

Fig. 8-8: Selection list for file archive

Entering Archive Information
The user can enter his name and any commentary on the archive to be
created in this screen mask. Entry of a name is mandatory, a
commentary may be entered if so desired.

3BackInfo_gr.bmp

Fig. 8-9: Entry dialog for file information
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⇒ Enter the name of the author; date and time will be entered
automatically by the system. Enter any desired comment text in the
text field and press the Execute button.
The archiving is started. The data is copied to a temporary directory.

If a floppy drive has been selected as backup destination drive, a prompt
will be displayed asking whether the diskette should be formatted.

3format.pcx

Fig. 8-10: Dialog for formatting

⇒ Confirm with Yes if the diskette is to be formatted
- or -
 press No if formatting is not required.
⇒ Insert the first diskette into the drive when requested and press Yes.
The compression procedure then starts. A dialog window with a progress
display gives information on the archiving status. If the backup file is to be
saved on several diskettes, insertion of new diskettes will be requested.
When archiving is finished, the file information window is again displayed.
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Finishing Archiving
After the archive has been created, the information window for the just-
created archive is displayed again for the last time.

3BackFertig_gr.bmp

Fig. 8-11: Final dialog after finishing the backup

⇒ Terminate archiving by pressing Ready.
Archiving is now terminated, the program is exited.

8.6 Executing a Restore

Prerequisites
• The restore program requires unlimited and exclusive access to the

files to be saved. It is therefore necessary that all active applications
(user interface, function interface, System Configurator) are
terminated.

• The drive with the archived data must be ready (MO drive switched
on). If the data is saved on diskettes, all diskettes must be available.

Note: Labels are assigned to the backup diskettes by the program.
This designation is required for the restore procedure. If
diskettes are copied or forwarded electronically, the labels
assigned to the diskettes must be also forwarded.

Using the Restore Program
Restore is also carried out with the help of a dialog Assistant. After
selecting an option, pressing the Cont. button leads to the subsequent
dialog. The Return button leads to the previous dialog. The archiving
procedure is started in the last dialog by pressing Execute.
Function key F1 opens the help function at any time. The table of
contents points to the required topic. The various backup mechanisms
are described.

Assistant

Online Help
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Calling the Restore Program
The restore program is called via the Windows start menu.
⇒ Open the program with the Start - Programs - Indramat - Restore

menu sequence
The program is loaded. The dialog window with the selection list of
available file archives is displayed.

3RestArchiv_gr.bmp

Fig. 8-12: Selection list for file archive

In the selection list , all archive files already created are displayed.
⇒ Select the archive to be restored from the list
- or -
⇒ press the File selection button in order to select a valid ZIP archive

not shown in the list. If the ZIP archive is saved on a diskette, a
prompt to first insert the last archive diskette into the floppy drive will
be displayed. The program requires this diskette in order to
determine the archive size. After archive selection, the file information
window is displayed.

⇒ Press the Execute button to start the restore function.
A message box asks if existing user data is to be deleted during
restore.

3RestDel.pcx

Fig. 8-13: Delete existing user data?
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⇒ If the dialog is answered with Yes, the directories will only include
archive data; temporary data will be lost.

- or -

⇒ If the question is answered with No, temporary data will remain.
⇒ Answer the dialog “Is last medium in drive?” with Yes if the archive is

located on the inserted medium. Otherwise change the medium.

Note: Occasionally, several prompts to change the diskettes are
issued. This is unavoidable if the internal ZIP archive file is
split onto two diskettes.

The ZIP data is copied to a temporary directory and then to the
destination directories. The procedure is shown in a progress display.

When the restore is finished, the file information window is displayed.
⇒ Terminate the restore by pressing Ready.
The restore procedure is now terminated, the program is exited.

Restoring Control Data
After the restore, data that can be modified within the controller (NC
variables, NC events, D-corrections, tool lists, zero offset data, machine
data, residual PLC data) must be restored into the controller.
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9 Complete Backup

9.1 Chapter Overview
This chapter describes the complete backup with the help of external data
backup programs.

9.2 Procedure
With the help of an external program, individual partitions of a hard disk or
the complete contents of a hard disk are written into an image file. This
image file represents a complete copy of the data storage medium. All
system data and system settings are saved. In addition to the control
software program data and user data, the operating system programs and
settings and any external software, if present, are also saved.
When data is lost or the hard disk is replaced, the image file is restored to
the data storage medium.

Procedure Overview
All system data is saved during the complete backup,. All files must
therefore be closed and the system must be shut down. The system is
started at the workstation with the help of a boot diskette. The boot
diskette includes all necessary programs and device drivers for the data
backup. The data backup program creates an image file which is saved
on the data storage medium. If a MO drive is used for backup, an
individual data storage medium is used for each station.

backup

restore

Programs,
settings

MO-D
riv

e

BTV 20 Data storage medium

Boot diskette with drivers for
MO drive and network

4Kpl-verf.FH7

Fig. 9-1: Overview of the archiving procedure

Backup

Restore
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1. Shut down system
2. Start station with boot diskette

• Operating system is loaded
• Network drivers are loaded
• Device drivers for MO drive are loaded

3. Load data backup program
4. Execute backup interactively or with batch file

1. Shut down system
2. Start station with boot diskette

• Operating system is loaded
• Network drivers are loaded
• Device drivers for MO drive are loaded

3. Load data backup program
4. Execute restore interactively or with batch file

Depending on the system configuration, the data backup is executed on
local data storage media or on a data storage medium connected via
Ethernet.

Local Data Storage Media
On single-seat systems, data backup is executed on a mass storage
medium connected to the BTV. A second hard disk in the BTV is also
suitable.

MO-D
riv

e

Parallel port

BTV MO drive or hard disk

Boot diskette with drivers for
MO drive

4Lok-MO-HD.FH7

Fig. 9-2: Local data backup on MO drive or second hard disk

Backup - Saving data

Restore - Restoring data
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Networked Data Storage Media
For networked systems, central data backup via Ethernet is recom-
mended. The mass storage media of a networked backup PC or an MO
drive connected to the master controller can be used. The advantages
and disadvantages of data backup via the data network are as follows:
• Only one mass storage medium is necessary at the central location
• The mass storage medium (MO drive) does not have to be connected

to each station
The network connection must be created under MS-DOS; an additional
program (MS-CLIENT) is necessary for this.

�����
���

������������	


���
�

��������


���
� 
���
�

�	�����	


��	������		� 
��	������		�

4Net-kopf.FH7

Fig. 9-3: Backup to master controller MO drive

MO-Drive

Parallel port

BTV 20
Master station

MO drive

BTV 20 BTV 20

Ethernet

Backup PC

Boot diskette Boot diskette

4Net-PC.FH7

Fig. 9-4: Data Backup on hard disk or MO drive of the backup PC

Advantages

Disadvantages
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9.3 Hardware and Software Requirements
The components described as follows must be available for data backup
with the shown configuration.
For data backup on a MO drive connected to the work station the fol-
lowing are needed:
• a bootable diskette
• MO drive with 640 MB disk (Fujitsu M2 13)
• a backup program (Norton Ghost Pro 5.1d, DriveImage Pro 3.0,

HDCOPY 2.0 Pro)
- or -
for data backup via Ethernet to MO drive or hard disk:
• a bootable diskette
• network under DOS (created using MS-Client)
• MO drive with 640 MB disk (Fujitsu M2 13)
• a backup program (Norton Ghost Pro 5.1d, DriveImage Pro 3.0,

HDCOPY 2.0 Pro).

9.4 Programs for Data Backup
Three programs for data backup are introduced in these instructions. With
the help of these programs, complete hard disks or single data storage
medium partitions can be transferred to another data storage medium. All
partition data and data storage medium settings are saved. This allows
complete duplication of a data storage medium. Depending on the
program, further possibilities for complete or a differentiated data backup
on various mediums and with various transfer possibilities are offered.
The selection and the order of the programs shown in this description do
not imply any judgement on their respective usefulness. Each program
has advantages and disadvantages in each of the functions. If necessary,
test the programs to find the one most suited to requirements. The
manufacturers offer free trial versions that may be used for this purpose.

Note: Please also refer to the corresponding manufacturer’s
documentation.
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9.5 Preparations
Before the data backup can be successfully executed, some preparations
must be made. In detail, the user must:
• create a boot diskette
• set-up the network client for image file transfer over the network
• install the drivers for the MO drive
• set up the data backup program
Depending on whether the data backup is executed at the local
workstation or over Ethernet, different diskettes are needed. The
diskettes must be bootable and must contain all system files and drivers
necessary for the given configuration.

Creating a Diskette for Backup on MO Drive
For data backup on a MO drive connected locally or connected via the
parallel port, a boot diskette with the necessary device drivers is needed.
These should furthermore contain the auxiliary program “HDPREP.EXE”
for formatting the diskettes and the “AUTOEXEC.BAT” and
“CONFIG.SYS” MS-DOS files.

AUTOEXEC.BAT
CONFIG.SYS
ASPIHDRM. SYS
EPST. EXE
EPST.SYS
ASPICD.SYS
SHTLMAN.DAT
HDPREP.EXE
HDPREP.DAT
HDPREP.HLP

MS-DOS files

Device drivers for MO drive

Auxiliary program for data storage medium formatting

4Start-MO.FH7

Fig. 9-5: Contents of the boot diskette for local data backup on MO drive

Device = epst.sys
Device = aspihdrm.sys
BUFFERS=10,0
FILES=30
LASTDRIVE=Z
FCBS=4,0

Fig. 9-6: Contents of the CONFIG.SYS file

keyb gr
Fig. 9-7: Contents of the AUTOEXEC.BAT file

Furthermore, the diskette can contain the batch files for the backup
(BACKUP.BAT) and restore (RESTORE.BAT) for the data backup
program.

REM BACKUP.BAT
REM saves the complete hard disk in an image file on MO
drive E:
ghost –xint13on -sure –z1
-clone,mode=dump,src=1,dst=E:\BTV01.IMG

Fig. 9-8: Example of a BACKUP.BAT batch processing file

Preparing diskettes

Boot diskette

CONFIG.SYS

AUTOEXEC.BAT

BACKUP.BAT
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REM RESTORE.BAT
REM Restore the complete hard disk from an image file from
MO drive E:
ghost –xint13on -sure
-clone,mode=load,src= E:\BTV01.IMG,dst=1

Fig. 9-9: Example of a RESTORE.BAT batch processing file

⇒ In addition, copy the data backup program to this diskette. If an ASCII
editor (for editing the batch files) is also copied to the diskette, all
necessary files for data backup are contained on one diskette.

Creating a Diskette for Data Backup with Ethernet
For data backup over Ethernet, a bootable diskette with drivers and
system files for a network running under MS-DOS is necessary. A DOS
network can be created using the Microsoft MS-CLIENT product. MS-
CLIENT is included in the “WINDOWS NT SERVER” program package
and can be found on the installation CD.
The network client must be configured for the network card in use. The
necessary system programs and drivers can be saved on one boot
diskette. For a SMC9000 network card, the diskette must have the
following content (see Fig. 4.10)
⇒ Create a network diskette with the help of MS-CLIENT
⇒ Compare the contents of the network diskette and the contents of the

files AUTOEXEC.BAT, CONFIG.SYS, SYSTEM.INI and
PROTOCOL.INI with the listings of the following figures and edit them
if necessary.

If another configuration is needed, for example if another network card is
used, call SETUP.EXE in order to reconfigure MS-CLIENT.

RESTORE.BAT
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COMMAND.COM
AUTOEXEC.BAT
CONFIG.SYS
KEYB.COM
KEYBOARD SYS
MSCLIENT     <DIR>

EXPAND.EXE
IFSHLP.SYS
NCDINFO.INI
NDISHLP.SYS
NDS91C95.DOS
NET.EXE
NET.MSG
NETH.MSG
NETWORK.INF
NWLINK.EXE
OEM0.INF
OEMDLC.INF
OEMODI.INF
OEMRAS.INF
OEMSETUP.INF
OEMTCPIP.INF
PROTMAN.DOS
PROTMAN.EXE
RASCOPY.BAT
SETUP.EXE
SETUP.INF
VSMCDUAL.386
WCSETUP.INF
WFWSYS.CFG
PROTOCOL.INI
SYSTEM.INI
SMC9000.DOS

MS-DOS files

MS-CLIENT files and
network card drivers in
sub-directory MSCLIENT

4Start-NET.FH7

Fig. 9-10: Contents of the boot diskette for networked operation

BUFFERS=10,0
FILES=30
LASTDRIVE=Z
FCBS=4,0
DEVICE=A:\MSCLIENT\IFSHLP.SYS

Fig. 9-11: Contents of the CONFIG.SYSfile

PATH=A:\;A:\MSCLIENT
keyb gr
A:\MSCLIENT\NET INITIALIZE
A:\MSCLIENT\NWLINK
A:\MSCLIENT\NET START
A:\MSCLIENT\NET

Fig. 9-12: Contents of the AUTOEXEC.BAT file

Boot diskette

CONFIG.SYS

AUTOEXEC.BAT
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[network.setup]
version=0x3110
netcard=smc9000,1,SMC9000,1
transport=ms$nwlink,MS$NWLINK
transport=ms$ndishlp,MS$NDISHLP
transport=ms$netbeui,MS$NETBEUI
lana0=smc9000,1,ms$nwlink
lana1=smc9000,1,ms$ndishlp
lana2=smc9000,1,ms$netbeui
[MS$NWLINK]
FRAME=ETHERNET_802.2
DriverName=nwlink$
BINDINGS=SMC9000
[protman]
DriverName=PROTMAN$
PRIORITY=MS$NDISHLP
[SMC9000]
DriverName=SMC9X$
IOBase=0x280
[MS$NDISHLP]
DriverName=ndishlp$
BINDINGS=SMC9000
[MS$NETBEUI]
DriverName=nnetbeui$
Sessions=10
NCBS=12
BINDINGS=SMC9000
LANABASE=1

Fig. 9-13: Contents of the PROTOCOL.INI file

Network settings must be edited in the SYSTEM.INI MS-CLIENT file (in
the \MSCLIENT directory on the diskette).
⇒ Overwrite the default settings with the correct values for the network

being used. In case of doubt consult a network administrator.
The following settings must be modified:
• Computer name
• User name
• Workgroup

PROTOCOL.INI

SYSTEM.INI  settings
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The following figure shows the lines (marked) where modifications are
necessary.

[network]
sizworkbuf=1498
filesharing=no
printsharing=no
autologon=yes
computername=MAHO 
lanroot=A:\MSCLIENT
username=Wirthmann_Egon
workgroup=ESM1
reconnect=yes
dospophotkey=N
lmlogon=0
logondomain=
preferredredir=full
autostart=
maxconnections=8
[network drivers]
netcard=SMC9000.dos
transport=ndishlp.sys,*netbeui
devdir=A:\MSCLIENT
LoadRMDrivers=yes
[Password Lists]
*Shares=A:\MSCLIENT\Share000.PWL
SYSTEM200=A:\MSCLIENT\SYSTEM20.PWL

Fig. 9-14: SYSTEM.INI MS-CLIENT settings

Transferring the Operating System to Diskette
For starting the system, the diskettes for MO and network operation
should include the operating system. For this, the DOS command
“SYS.COM” in a MS DOS system should be used. The operating system
is transferred to diskette in this way.
⇒ Create one bootable diskette with the operating system MS-DOS from

the two start diskettes for network and MO operation.

9.6 The Norton Ghost 5.1d Program
The Norton Ghost 5.1d program from Symantec is a DOS program. It is
not possible to start it in the DOS window under Windows NT. Windows
NT does not permit exclusive access to data media. Two modes are
available for program settings and data backup.
The software is set up and operated via menu calls. The selection of the
areas of data to be saved and the settings of destination drives, etc. are
done by means of program dialogs.
The program can be started in batch mode for fast, automatic processing.
Various parameters can be added to the call name of the program in a
batch file. The backup and/or restore operation can then be run fully
automatically by calling the batch file.

Interactive operation

Batch operation
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Setting up a Diskette for Ghost
The Ghost DOS program does not have to be installed. It is sufficient to
copy the “GHOST.EXE” program file to a formatted diskette. Ghost can
be copied to the starting diskette for data backup on a local MO drive. The
start diskette storage capacity is not sufficient for network operation. For
Ghost, a second diskette must be inserted.
Set up the software as required by selecting program options interactively
or by setting call parameters.

Setting Options for Interactive Operation
The program options are determined in the Options menu.
For example, the image file can be set up such that it is split onto multiple
data storage media (spanning) or that safety prompts are not displayed
(Sure).
⇒ Select the Options menu.

An entry field with flags is displayed.
⇒ Move from flag to flag with the Tab key

The active field is illuminated, a help text is displayed in the form of a
balloon.

⇒ Press Enter in order to activate the option.
A check mark displays that the option is selected.

⇒ Set the required options
⇒ Press the Accept button

The settings are applied.

4Optionen.tif

Fig. 9-15: The settings in the “Options” menu
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Creating or Modifying a Batch File
The program settings are added as parameters to the call names of the
program with the help of a batch file. The batch file should be structured
as follows.

Batch File for Backup in an Image File
REM BACKUP.BAT
REM saves the complete hard disk in an image file on drive E: (Network drive or MO drive)
ghost -sure –z1 -clone,mode=dump,src=1,dst=E:\BTV01.GHO

Fig. 9-16: Batch file for backup in an image file

⇒ Open the batch file  in an ASCII editor and edit the destination drive
and the file name of the backup file as necessary.

Batch File for Restoring Data from an Image File

REM RESTORE.BAT
REM Restore the complete hard disk from an image file on drive E:
ghost -sure –z1 -clone,mode=load,src=E:\BTV01.GHO,dst=1

Fig. 9-17: Batch file for restoring from an image file

Destination drive E: and backup
file name

Source: drive to be backed up (1st hard disk)

Backup mode (Create image)

Switches compression on (compression type: “fast”)

Switches security prompt off when program executing

Backup program call name

Source: Drive E: and backup file
name

Destination: 1st hard disk

Backup mode (reload image)

Switches compression on (fast)

Switches security prompt off when program executing

Backup program call name
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Optional Parameters
If the storage capacity of the connected MO drive is not sufficient, the
image file can be saved on multiple data storage media. To do this, the
“-span” parameter must be entered in the batch file.
Using the parameter “-z”, two modes can be selected for compression of
the image file.
-z1: Compression “fast”; the image file is compressed to approximately
60% of the original size. The backup time is 10% less than without
compression. (Less data must be transferred through the relatively slow
network connection or to the MO drive connected in parallel). This is the
recommended compression mode.
-z2: Compression “high”; the image file is compressed to approximately
50% of the original size. However, the backup takes approximately three
times longer than without compression. This compression mode is not
recommended.

Note: For further settings such as copying individual partitions,
please refer to the Ghost product documentation.

9.7 The DriveImage Pro 3.0 Program
The DriveImage Pro 3.0 program from Powerquest can be started from
hard disk under Windows 95/98 or from a bootable diskette. It is not
possible to start it in the DOS window under Windows NT. Start the
program under Windows NT from a bootable diskette or a bootable DOS
partition of the hard disk.
Two modes are available for program settings and data backup.
The software is set up and operated via menu calls. The selection of the
areas of data to be saved and destination drive settings, etc. are done by
the program by means of dialogs.
The program can be started in batch mode for fast, automatic processing.
Various parameters can be added to the call name of the program in a
batch file and a script file. The backup and/or restore operation can then
be run fully automatically by calling the batch file.

Setting up a Diskette for DriveImage
The DriveImage program is installed from the installation CD. The set-up
program copies all necessary data to the hard disk. The set-up program
allows to create the necessary diskettes for diskette operation. A bootable
diskette with the drivers for external data storage mediums and a program
diskette for DriveImage are created.
⇒ Select the option Create emergency diskettes in the set-up

program.
Adjust the software to your requirements by selecting program options
interactively or by setting call parameters.

-span

-z

Interactive operation

Batch operation
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Setting Options for Interactive Operation
The program interface is similar to Windows and offers assistance; it can
be operated with the keyboard or the mouse.
Advanced Options offers special settings e. g. to protect the image file
with a password orto split the image file into multiple files with a fixed size
each.

4SpezOpt.tif

Fig. 9-18: Assisted “Advanced Options” menu

Creating or Modifying a Batch File
The program settings can be attached to the program call with the help of
a batch file or a script file. The batch file should be structured as follows.

Batch File for Backup in an Image File
The following figure shows a simple batch file. With its help, the complete
hard disk (all partitions) with the main program settings on drive E: are
written in the BTV01.PQI image file.

REM BACKUP.BAT
REM saves the complete hard disk in an image file on drive E: (Network drive or MO drive)
PQDI /CMD=STORE_ALL /IMG=E:\BTV01.PQI

Fig. 9-19: Batch file for easy backup in an image file

Destination drive E: and backup file name

Select complete hard disk for backup

Backup program call name
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⇒ Open the batch file  in an ASCII editor and edit the destination drive
and the file name of the backup file as necessary.

For differentiated backups it is necessary to create a script file. This is
then executed via the batch file.

Application Example 1
Partition 3 on drive 1 and partitions 1 and 4 on drive 2 are to be written in
the file E:\BTV20.PQI. Furthermore, the image file must be limited to
630 MB so it can be copied to an MO or to a CD.
The script file which is to be executed, the destination file for the image,
and the file size limit are entered in the batch file.

REM BACKUP.BAT
PQDI /CMD=BACK_01.TXT /IMG=E:\BTV20.PQI /MFS=630000000

Fig. 9-20: Batch file for backing up a partition

The BACK_01.TXT script file includes the call parameters to be trans-
ferred to the program.

SELECT DRIVE 1

SELECT PARTITION 3

STORE

SELECT DRIVE 2

SELECT PARTITION 1

SELECT PARTITION 4

STORE

Fig. 9-21: Script file for backup

Batch file

Script file

Destination drive E: and backup
file name

Script file to be called

Backup program call name

Limits backup file size to 630 MB

Select 1st hard disk

Select 3rd partition on 1st disk

Backup to file

Select 1st partition on 2nd disk

Select 2nd hard disk

Select 4th partition on 2nd disk

Backup to file
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Batch File for Restoring Data from an Image File
Using the following batch file, an image file can be easily completely
restored.

REM BACKUP.BAT
REM restores the complete hard disk from an image file on drive E: restore
PQDI /CMD=RESTORE_ALL /IMG=E:\BTV01.PQI

Fig. 9-22: Batch file for easy restore of an image file

⇒ Open the batch file  in an ASCII editor and modify the destination
drive and the file name of the image file as necessary.

A script file can be used for restore details. In this way the partition size,
for example, can be modified or single partitions selected.

Application Example 2
The first two images of the E:\BTV20.PQI file are to be restored to the last
free memory area. The size of each image is to be limited to 500 MB. The
image file is protected with the password “SECURE”.
The script file (REST_01.TXT) to be called, the image file (BTV20.PQI) to
be restored and the password (SECURE) for the image file are entered in
the batch file.

REM REST_P1.BAT
REM Restore the 2nd partition of the 1st hard disk from image file on drive E:
PQDI /CMD=REST_01.TXT /IMG=E:\BTV20.PQI /PWD=SECURE

Fig. 9-23: Batch file for an extended restore

Batch file

Destination drive E: and backup
file name

Select complete hard disk for restore

Backup program call name

Drive E: and image
file name

Backup program call name

Aufrufname des Datensicherungsprogramms

Image file password
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The REST_01.TXT script file includes the call parameters which are to be
transferred to the program.

SELECT DRIVE 1

SELECT FREESPACE LAST

SELECT IMAGE 1

RESIZE IMAGE 500

SELECT IMAGE 2

RESIZE IMAGE 500

RESTORE

Fig. 9-24: Script file for backup

Note: For further settings such as compressing files, please refer to
the DriveImage product documentation.

9.8 The HDCOPY 2.0 Pro Program
The HDCOPY 2.0 Pro program from HDTRONIC EDV Service GmbH is a
DOS program. It is not possible to start it in the DOS window under
Windows NT. Windows NT does not allow exclusive access to data
media. Two modes are available for program settings and data backup.
The software is set up and operated via menu calls. Selection of data
areas to be saved and settings of destination drives, etc. are executed by
program menu entries.
The program can be started in batch mode for fast, automatic processing.
Various parameters can be added to the call name of the program in a
batch file. The backup and/or restore operation can then be run fully
automatically by calling the batch file.

Setting up a Diskette for HDCOPY
The HDCOPY DOS program does not have to be installed. It is sufficient
to copy the original diskettes files to a formatted diskette. For data backup
on a local MO drive, HDCOPY can be copied to the start diskette. The
start diskette storage capacity is not sufficient for network operation. For
HDCOPY, a second diskette must be inserted.
Set up the software as required by selecting program options interactively
or by setting call parameters.

Script file

Interactive operation

Batch operation

Select 1st hard disk

Select last free memory

Select image 1

Select image 2

Set size for image 1

Set size for image 2

Restore
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Setting Options for Interactive Operation
In the Options menu, define the program settings for executing data
backup.
For example, the size of the image file can be determined or compression
can be selected or deselected.

4Optionen.pcx

Fig. 9-25: Options menu

The following options can be set.
• Backup mode

Determines if the partitions are saved logically or physically.
• Last track

Use of the last track can be activated in order to make up to 8 MB hard
disk memory available.

• Image file size
Image file size can be limited in order to transfer the image file to a
MO drive or to a CD-ROM.

• Compression
If compression is active, the image file size will be reduced by approxi-
mately 50%. This is recommended if not enough memory is available
or if the backup is to be saved to a slow medium (MO drive).
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Creating or Modifying a Batch File
The program settings are added as parameters to the call names of the
program with the help of a batch file. The batch file should be structured
as follows.

Batch File for Backup in an Image File
The following batch file saves all partitions of the first hard disk of the
system in the BTV01.IMG file on drive E.

REM BACKUP.BAT
REM saves the complete hard disk in an image file on drive E: (Network drive or MO drive)
PQDI /CMD=STORE_ALL /IMG=E:\BTV01.PQI

Fig. 9-26: Batch file for backup in an image file

⇒ Open the batch file  in an ASCII editor and edit the destination drive
and the file name of the backup file as necessary.

Batch File for Restoring Data from an Image File
To restore an image file, in addition to the batch file, a make file is ne-
cessary. This file includes the necessary information in script form for a
detailed restore.

The script file to be called is entered in the batch file.

REM RESTORE.BAT
HDCOPY -R A:\BTV01.MAK

Fig. 9-27: Batch file for restore of a partition

Batch file

Destination drive E: and backup
file name

Source: Drive to be backed up (0 = 1st hard disk)

Partition to be backed up (0 = all partitions)

Switches BACKUP mode on

Backup program call name

Make file to be called

Backup program to be called

Switches RESTORE mode on
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The BTV01.MAK make file includes the call parameters which are to be
transferred to the program. The first and the last line are important and
must always be present.

HDCOPY Make file for restore

; Restore complete hard disk

Drive=0

Keyboard=0

Action=L

Number=0

Action=R

File=D:\BTV01.IMG

Index=0

HDCOPY Make End

Fig. 9-28: Script file for backup

Note: For further settings such as modifying partition size, please re-
fer to the HDCOPY product documentation.

9.9 Executing Data Backup to a Local MO Drive

Prerequisites
• The MO drive is connected to the parallel port and is ready for oper-

ation.
• A formatted data storage medium with enough storage capacity is in-

serted in the MO drive
• A bootable diskette with device drivers and the backup program has

been created
• Controller data that can be modified (NC variables, NC events, D-cor-

rections, tool lists, zero offset data, machine data, residual PLC data)
are saved on hard disk. For procedure see.

Make file

Mandatory, make file recognition done in
this line

Optional comment line, starts with “;”

Select 1st hard disk

Following selected partitions are deleted

Keyboard input is not suppressed

0 = all partitions selected

Restore selected

File to be restored from

Position of partition  (0 = complete restore)

Mandatory, end of make file
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Editing a batch file
Edit the BACKUP.BAT batch file on the diskette.
⇒ Open the batch file in an ASCII editor
⇒ Enter the drive letter for the MO drive and determine a name for the

image file to be created.
⇒ Save the modified file to the diskette

Executing a backup
⇒ Shut down the system
⇒ Insert the diskette in the boot drive and start the computer again

The computer starts from diskette and loads the device drivers for the
MO drive

⇒ Start the program by entering the start name at the prompt and
execute it interactively.

- or -

⇒ Call the “BACKUP.BAT” batch file at the prompt
The program is loaded and started automatically. A progress bar on
the screen displays the data backup progress. Depending on the pro-
gram, the statistics show further information about data volume, data
throughput and remaining backup time.

When data backup is finished, the program is automatically exited.

9.10 Executing Data Backup on a Network Drive

Prerequisites
• A bootable diskette using Network Client has been created.
• A diskette with the data backup program and the BACKUP.BAT batch

file is available.
• The network drive (hard disk, MO drive), to which the data backup is

to be executed, is available.
• The backup drive is ready (MO drive switched on) and has enough

storage capacity.
• Controller data that can be modified (NC variables, NC events, D-

corrections, tool lists, zero offset data, machine data, residual PLC
data, SERCOS parameters) is saved to hard disk. For procedure see
1260960.1258384 .

Editing a batch file
Edit the BACKUP.BAT batch file on the program diskette.
⇒ Open the batch file in an ASCII editor
⇒ Enter the drive letter for the network drive and determine a name for

the image file to be created.
⇒ Save the modified file to the diskette
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Creating a network connection
⇒ Shut down the system
⇒ Insert the boot diskette in the boot drive and start the computer again

The computer starts from diskette; the drivers for the network are
loaded and MS-CLIENT is started.

⇒ Confirm the question whether the network service is to be started with
“Y” for Yes.
The workstation service is started.

⇒ Enter user name and password when prompted.
If this is a first-time start, the password must be again confirmed.

Information about the network connection must be entered in the following
screen. Moving around within the screen mask is done using the Tab key.

4Netpfad.pcx

Fig. 9-29: Screen mask for network connection

⇒ Enter the path for the network computer backup drive (see above
figure).
The path name is inserted in the list of current connections. The drive
letter assigned to this connection is displayed in this list.

If an error message (error 53) is displayed:
The connection cannot be created because the indicated computer name
cannot be found.
• Check whether the indicated path exists in the current network and

whether the computer has been started
• Make sure that the path name starts with an double backslash (\\).
⇒ Mark “Reconnect at Startup” if the same drive is always to be used for

saving to.

⇒ Exit the screen mask with the Exit button
The connection to the network drive has been now created.

Executing a backup
⇒ Insert the diskette with the data backup program
⇒ Start the program by entering the start name at the prompt and

execute it interactively.
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- or -

⇒ Call the “BACKUP.BAT” batch file at the prompt
The program is loaded and started automatically. A progress bar on
the screen displays the data backup progress. Depending on the pro-
gram, the statistics show further information about data volume, data
throughput and remaining backup time.

When data backup is finished, the program is automatically exited.

Restoring Data
The same procedure is principally used for restoring data. The hard disk
content is completely recreated by writing back the image file. This ver-
sion of Ghost does not allow restoring of individual files. If the hard disk
“Autoconfiguration” entry in the BIOS is set, it is not necessary to log the
new hard disk in the BIOS after replacing it. In addition, the hard disk
does not have to be partitioned and formatted. Partition data is saved by
Ghost and again retransferred.

Restoring from a Local MO Drive
⇒ Insert the MO disk with the image file into the MO drive
⇒ Boot the workstation with the start diskette for the MO drive

The MO drive drivers are loaded
⇒ Modify the path and file names in the RESTORE.BAT batch file on

the diskette as necessary
⇒ Start Ghost by entering “GHOST” at the prompt and execute it inter-

actively.
- or -
⇒ Start the restore by calling the RESTORE.BAT batch file.

The image file is restored and the hard disk data is recreated. When
the restore is finished, the program is exited.



System Services 21VRS Complete Backup 9-23

DOK-CONTRL-SYS*SER*V21-AW01-EN-P

Restoring from a Network Drive
⇒ Make sure that the computer with the backup file is ready and the

drive is available.
⇒ Boot the workstation with the start diskette for the network drive

The computer starts from diskette; the drivers for the network are
loaded and MS-CLIENT is started.

⇒ Confirm the question whether the network service is to be started with
“Y” for Yes.
The workstation service is started.

⇒ Enter user name and password when prompted.
⇒ Enter the path of the backup drive on the network computer in the fol-

lowing screen. The path name is inserted in the list of current connec-
tions. The letter of the drive which has been assigned to this connection
is displayed in this list.

⇒ Finish the dialog by pressing the Ready button
⇒ Modify the path and file names in the RESTORE.BAT batch file on

the diskette
⇒ Start the program at the prompt and execute it interactively
- or -
⇒ Start the restore by calling the RESTORE.BAT batch file.

The image file is restored and the hard disk data is recreated. When
the restore is finished, the program is exited.
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12 Service & Support

12.1 Helpdesk
Unser Kundendienst-Helpdesk im Hauptwerk Lohr
am Main steht Ihnen mit Rat und Tat zur Seite.
Sie erreichen uns

- telefonisch: +49 (0) 9352 40 50 60
über Service Call Entry Center Mo-Fr   07:00-18:00

- per Fax: +49 (0) 9352 40 49 41

- per e-Mail: service@indramat.de

Our service helpdesk at our headquarters in Lohr am
Main, Germany can assist you in all kinds of inquiries.
Contact us

- by phone: +49 (0) 9352 40 50 60
via Service Call Entry Center Mo-Fr 7:00 am - 6:00 pm

- by fax: +49 (0) 9352 40 49 41

- by e-mail: service@indramat.de

12.2 Service-Hotline
Außerhalb der Helpdesk-Zeiten ist der Service
direkt ansprechbar unter

+49 (0) 171 333 88 26
oder +49 (0) 172 660 04 06

After helpdesk hours, contact our service
department directly at

+49 (0) 171 333 88 26
or +49 (0) 172 660 04 06

12.3 Internet

Unter www.indramat.de finden Sie
ergänzende Hinweise zu Service, Reparatur und
Training sowie die aktuellen Adressen *) unserer
auf den folgenden Seiten aufgeführten Vertriebs-
und Servicebüros.

Verkaufsniederlassungen
Niederlassungen mit Kundendienst

Außerhalb Deutschlands nehmen Sie bitte zuerst Kontakt mit
unserem für Sie nächstgelegenen Ansprechpartner auf.

*) http://www.indramat.de/de/kontakt/adressen
Die Angaben in der vorliegenden Dokumentation können
seit Drucklegung überholt sein.

At www.indramat.de you may find additional
notes about service, repairs and training in the
Internet, as well as the actual addresses *) of our
sales- and service facilities figuring on the following
pages.

sales agencies
offices providing service

Please contact our sales / service office in your area first.

*) http://www.indramat.de/en/kontakt/adressen
Data in the present documentation may have become
obsolete since printing.

12.4 Vor der Kontaktaufnahme... - Before contacting us...
Wir können Ihnen schnell und effizient helfen wenn
Sie folgende Informationen bereithalten:
1. detaillierte Beschreibung der Störung und der

Umstände.
2. Angaben auf dem Typenschild der betreffenden

Produkte, insbesondere Typenschlüssel und
Seriennummern.

3. Tel.-/Faxnummern und e-Mail-Adresse, unter
denen Sie für Rückfragen zu erreichen sind.

For quick and efficient help, please have the
following information ready:
1. Detailed description of the failure and

circumstances.
2. Information on the type plate of the affected

products, especially type codes and serial
numbers.

3. Your phone/fax numbers and e-mail address,
so we can contact you in case of questions.

http://www.indramat.de/en/kontakt/adressen
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12.5 Kundenbetreuungsstellen - Sales & Service Facilities

Deutschland – Germany vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Vertriebsgebiet Mitte
 Germany Centre

Rexroth Indramat GmbH
Bgm.-Dr.-Nebel-Str. 2 / Postf. 1357
97816 Lohr am Main / 97803 Lohr

Kompetenz-Zentrum Europa

Tel.: +49 (0)9352 40-0
Fax: +49 (0)9352 40-4885

S E R V I C E
C A L L  E N T R Y  C E N T E R
MO – FR

von 07:00 - 18:00 Uhr

from 7 am – 6 pm

Tel. +49 (0) 9352 40 50 60
service@indramat.de

S E R V I C E
HOTLINE
MO – FR

von 17:00 - 07:00 Uhr
from 5 pm - 7 am

+ SA / SO

Tel.: +49 (0)172 660 04 06
oder  /  o r

Tel.: +49 (0)171 333 88 26

S E R V I C E
ERSATZTEILE / SPARES

verlängerte Ansprechzeit
- extended office time -

♦ nur an Werktagen
- only on working days -

♦ von 07:00 - 18:00 Uhr
- from 7 am - 6 pm  -

Tel. +49 (0) 9352 40 42 22

Vertriebsgebiet Süd
 Germany South

Rexroth Indramat GmbH
Landshuter Allee 8-10
80637 München

Tel.: +49 (0)89 127 14-0
Fax: +49 (0)89 127 14-490

Gebiet Südwest
 Germany South-West

Bosch Rexroth AG
Vertrieb Deutschland – VD-BI
Geschäftsbereich Rexroth Indramat
Regionalzentrum Südwest
Ringstrasse 70    /   Postfach 1144
70736 Fellbach   /    70701 Fellbach
Tel.: +49 (0)711 57 61–100
Fax: +49 (0)711 57 61–125

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Beckerstraße 31
09120 Chemnitz

Tel.: +49 (0)371 35 55-0
Fax: +49 (0)371 35 55-333

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Regionalzentrum Ost
Walter-Köhn-Str. 4d
04356 Leipzig

Tel.: +49 (0)341 25 61-0
Fax: +49 (0)341 25 61-111

Vertriebsgebiet West
 Germany West

Bosch Rexroth AG
Vertrieb Deutschland
Regionalzentrum West
Borsigstrasse 15
40880 Ratingen
Tel.: +49 (0)2102 409-0
Fax: +49 (0)2102 409-406

Vertriebsgebiet Mitte
 Germany Centre

Bosch Rexroth AG
Regionalzentrum Mitte
Waldecker Straße 13
64546 Mörfelden-Walldorf

Tel.: +49 (0) 61 05 702-3
Fax: +49 (0) 61 05 702-444

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Walsroder Str. 93
30853 Langenhagen

Tel.: +49 (0) 511 72 66 57-0
Service: +49 (0) 511 72 66 57-256
Fax: +49 (0) 511 72 66 57-93
Service: +49 (0) 511 72 66 57-95

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Kieler Straße 212
22525 Hamburg

Tel.: +49 (0) 40 81 955 966
Fax: +49 (0) 40 85 418 978

mailto:service@indramat.de
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Europa (West) - Europe (West)

vom Ausland: (0) nach Landeskennziffer weglassen, Italien: 0 nach Landeskennziffer mitwählen
from abroad:    don’t dial (0) after country code, Italy:    dial 0 after country code

Austria - Österreich

Bosch Rexroth GmbH
Bereich Indramat
Stachegasse 13
1120 Wien
Tel.: +43 (0)1 985 25 40
Fax: +43 (0)1 985 25 40-93

Austria – Österreich

Bosch Rexroth G.m.b.H.
Gesch.ber. Rexroth Indramat
Industriepark 18
4061 Pasching
Tel.: +43 (0)7221 605-0
Fax: +43 (0)7221 605-21

Belgium - Belgien

Bosch Rexroth AG
Electric Drives & Controls
Industrielaan 8
1740 Ternat
Tel.: +32 (0)2 5830719
- service: +32 (0)2 5830717
Fax: +32 (0)2 5830731
 indramat@boschrexroth.be

Denmark - Dänemark

BEC A/S
Zinkvej 6
8900 Randers

Tel.: +45 (0)87 11 90 60
Fax: +45 (0)87 11 90 61

Great Britain – Großbritannien

Bosch Rexroth Ltd.
Rexroth Indramat Division
Broadway Lane, South Cerney
Cirencester, Glos GL7 5UH

Tel.: +44 (0)1285 863000
Fax: +44 (0)1285 863030
 sales@boschrexroth.co.uk
 service@boschrexroth.co.uk

Finland - Finnland

Bosch Rexroth Oy
Rexroth Indramat division
Ansatie 6
017 40 Vantaa

Tel.: +358 (0)9 84 91-11
Fax: +358 (0)9 84 91-13 60

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
Avenue de la Trentaine
BP. 74
77503 Chelles Cedex
Tel.: +33 (0)164 72-70 00
Fax: +33 (0)164 72-63 00
Hotline: +33 (0)608 33 43 28

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
1270, Avenue de Lardenne
31100 Toulouse

Tel.: +33 (0)5 61 49 95 19
Fax: +33 (0)5 61 31 00 41

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
91, Bd. Irène Joliot-Curie
69634 Vénissieux – Cedex
Tel.: +33 (0)4 78 78 53 65
Fax: +33 (0)4 78 78 53 62

Italy - Italien

Bosch Rexroth S.p.A.
Via G. Di Vittoria, 1
20063 Cernusco S/N.MI

Tel.: +39 02 2 365 270
Fax: +39 02 700 408 252378

Italy - Italien

Bosch Rexroth S.p.A.
Via Paolo Veronesi, 250
10148 Torino

Tel.: +39 011 224 88 11
Fax: +39 011 224 88 30

Italy - Italien

Bosch Rexroth S.p.A.
Via del Progresso, 16 (Zona Ind.)
35020 Padova

Tel.: +39 049 8 70 13 70
Fax: +39 049 8 70 13 77

Italy - Italien

Bosch Rexroth S.p.A.
Via Mascia, 1
80053 Castellamare di Stabia NA

Tel.: +39 081 8 71 57 00
Fax: +39 081 8 71 68 85

Italy - Italien

Bosch Rexroth S.p.A.
Viale Oriani, 38/A
40137 Bologna

Tel.: +39 051 34 14 14
Fax: +39 051 34 14 22

Netherlands – Niederlande/Holland

Bosch Rexroth B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 65 14 83
 indramat@hydraudyne.nl

Netherlands - Niederlande/Holland

Bosch Rexroth Services B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 67 78 14

Norway - Norwegen

Bosch Rexroth AS
Rexroth Indramat Division
Berghagan 1          or: Box 3007
1405 Ski-Langhus     1402 Ski

Tel.: +47 (0)64 86 41 00
Fax: +47 (0)64 86 90 62
 jul.ruud@rexroth.no

Spain - Spanien

Bosch Rexroth S.A.
Divisiòn Rexroth Indramat
Centro Industrial Santiga
Obradors s/n
08130 Santa Perpetua de Mogoda
Barcelona
Tel.: +34 9 37 47 94 00
Fax: +34 9 37 47 94 01

Spain – Spanien

Goimendi S.A.
División Rexroth Indramat
Parque Empresarial Zuatzu
C/ Francisco Grandmontagne no.2
20018 San Sebastian

Tel.: +34 9 43 31 84 21
- service: +34 9 43 31 84 56
Fax: +34 9 43 31 84 27
- service: +34 9 43 31 84 60
 sat.indramat@goimendi.es

Sweden - Schweden

Rexroth Mecman Svenska AB
Rexroth Indramat Division
- Varuvägen 7
(Service: Konsumentvägen 4, Älfsjö)
125 81 Stockholm

Tel.: +46 (0)8 727 92 00
Fax: +46 (0)8 647 32 77

Sweden - Schweden

Rexroth Mecman Svenska AB
Indramat Support
Ekvändan 7
254 67 Helsingborg
Tel.: +46 (0) 42 38 88 -50
Fax: +46 (0) 42 38 88 -74

Switzerland West - Schweiz West

Bosch Rexroth Suisse SA
Département Rexroth Indramat
Rue du village 1
1020 Renens
Tel.: +41 (0)21 632 84 20
Fax: +41 (0)21 632 84 21

Switzerland East - Schweiz Ost

Bosch Rexroth Schweiz AG
Geschäftsbereich Indramat
Hemrietstrasse 2
8863 Buttikon
Tel. +41 (0) 55 46 46 111
Fax +41 (0) 55 46 46 222

mailto:sales@indramat.co.uk
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Europa (Ost) - Europe (East)

vom Ausland: (0) nach Landeskennziffer weglassen  
from abroad:    don’t dial (0) after country code

Czech Republic - Tschechien

Bosch -Rexroth, spol.s.r.o.
Hviezdoslavova 5
627 00 Brno
Tel.: +420 (0)5 48 126 358
Fax: +420 (0)5 48 126 112

Czech Republic - Tschechien

DEL a.s.
Strojírenská 38
591 01 Zdar nad Sázavou
Tel.: +420 616 64 3144
Fax: +420 616 216 57

Hungary - Ungarn

Bosch Rexroth Kft.
Angol utca 34
1149 Budapest
Tel.: +36 (1) 364 00 02
Fax: +36 (1) 383 19 80

Poland – Polen

Bosch Rexroth Sp.zo.o.
ul. Staszica 1
05-800 Pruszków
Tel.: +48 22 738 18 00
– service: +48 22 738 18 46
Fax: +48 22 758 87 35
– service: +48 22 738 18 42

Poland – Polen

Bosch Rexroth Sp.zo.o.
Biuro Poznan
ul. Dabrowskiego 81/85
60-529 Poznan
Tel.: +48 061 847 64 62 /-63
Fax: +48 061 847 64 02

Rumania - Rumänien

Bosch Rexroth Sp.zo.o.
Str. Drobety nr. 4-10, app. 14
70258 Bucuresti, Sector 2
Tel.: +40 (0)1 210 48 25

+40 (0)1 210 29 50
Fax: +40 (0)1 210 29 52

Russia - Russland

Bosch Rexroth
Wjatskaja ul. 27/15
125015 Moskau
Tel.: +7-095-785 74 78

+7-095 785 74 79
Fax: +7 095 785 74 77
 laura.kanina@boschrexroth.ru

Russia - Russland

ELMIS
10, Internationalnaya Str.
246640 Gomel, Belarus
Tel.: +375/ 232 53 42 70

+375/ 232 53 21 69
Fax: +375/ 232 53 37 69
 elmis_ltd@yahoo.com

Turkey - Türkei

Bosch Rexroth Otomasyon
San & Tic. A..S.
Fevzi Cakmak Cad No. 3
34630 Sefaköy Istanbul
Tel.: +90 212 541 60 70
Fax: +90 212 599 34 07

Slowenia - Slowenien

DOMEL
Otoki 21
64 228 Zelezniki
Tel.: +386 5 5117 152
Fax: +386 5 5117 225
 brane.ozebek@domel.si
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Africa, Asia, Australia – incl. Pacific Rim
vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Australia - Australien

AIMS - Australian Industrial
Machinery Services Pty. Ltd.
Unit 3/45 Horne ST
Campbellfield , VIC 3061
Melbourne
Tel.: +61 (0) 393 590 228
Fax: +61 (0) 393 590 286
Hotline: +61 (0) 419 369 195
 terryobrien@aimservices.com.au

Australia - Australien

Bosch Rexroth Pty. Ltd.
No. 7, Endeavour Way
Braeside Victoria, 31 95
Melbourne

Tel.: +61 (0)3 95 80 39 33
Fax: +61 (0)3 95 80 17 33
 mel@rexroth.com.au

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
Wai Gao Qiao Free Trade Zone
No.122, Fu Te Dong Yi Road
Shanghai 200131 - P.R.China
Tel.: +86 21 58 66 30 30
Fax: +86 21 58 66 55 23
 roger.shi_sh@boschrexroth.com.cn

China

Bosch Rexroth (China) Ltd.
15/F China World Trade Center
1, Jianguomenwai Avenue
Beijing 100004, P.R.China

Tel.: +86 10 65 05 03 80
Fax: +86 10 65 05 03 79

China

Bosch Rexroth (China) Ltd.
A-5F., 123 Lian Shan Street
Sha He Kou District
Dalian 116 023, P.R.China

Tel.: +86 411 46 78 930
Fax: +86 411 46 78 932

China

Bosch Rexroth (Changzhou) Co.Ltd.
Guangzhou Repres. Office
Room 1014-1016, Metro Plaza,
Tian He District, 183 Tian He Bei Rd
Guangzhou 510075, P.R.China

Tel.: +86 20 8755-0030
+86 20 8755-0011

Fax: +86 20 8755-2387

Hongkong

Bosch Rexroth (China) Ltd.
6th Floor,
Yeung Yiu Chung No.6 Ind Bldg.
19 Cheung Shun Street
Cheung Sha Wan,
Kowloon, Hongkong
Tel.: +852 22 62 51 00
Fax: +852 27 41 33 44
alexis.siu@boschrexroth.com.hk

India - Indien

Bosch Rexroth (India) Ltd.
Rexroth Indramat Division
Plot. A-58, TTC Industrial Area
Thane Turbhe Midc Road
Mahape Village
Navi Mumbai - 400 701
Tel.: +91 (0)22 7 61 46 22
Fax: +91 (0)22 7 68 15 31

India - Indien

Bosch Rexroth (India) Ltd.
Rexroth Indramat Division
Plot. 96, Phase III
Peenya Industrial Area
Bangalore - 560058
Tel.: +91 (0)80 8 39 73 74
Fax: +91 (0)80 8 39 43 45
 rexbang@bgl.vsnl.net.in

Indonesia - Indonesien

PT. Rexroth Wijayakusuma
Building # 202, Cilandak
Commercial Estate
Jl. Cilandak KKO, Jakarta 12560

Tel.: +62 21 7891169 (5 lines)
Fax: +62 21 7891170 - 71

Japan

Bosch Rexroth Automation Corp.
Service Center Japan
Yutakagaoka 1810, Meito-ku,
NAGOYA 465-0035, Japan

Tel.: +81 (0)52 777 88 41
+81 (0)52 777 88 53
+81 (0)52 777 88 79

Fax: +81 (0)52 777 89 01

Japan

Bosch Rexroth Automation Corp.
Rexroth Indramat Division
1F, I.R. Building
Nakamachidai 4-26-44, Tsuzuki-ku
YOKOHAMA 224-0041, Japan
Tel.: +81 (0)45 942 72 10
Fax: +81 (0)45 942 03 41

Korea

Bosch Rexroth-Korea Ltd.
1515-14 Dadae-Dong, Saha-Ku
Rexroth Indramat Division
Pusan Metropolitan City, 604-050
Republic of South Korea

Tel.: +82 (0)51 26 00 741
Fax: +82 (0)51 26 00 747
 gyhan@rexrothkorea.co.kr

Malaysia

Bosch Rexroth Sdn.Bhd.
11, Jalan U8/82
Seksyen U8
40150 Shah Alam
Selangor, Malaysia
Tel.: +60 (0) 3 78 44 80 00
Fax: +60 (0) 3 78 45 48 00
 hockhwa@hotmail.com
 rexroth1@tm.net.my

Singapore - Singapur

Bosch Rexroth SDN BHD.
No.11, Jalan Astaka U8/82
Seksyen U8
40150 Shah Alam
Selangor Darul Ehsan

Tel.: +65 (0) 3 7844 8000
Fax: +65 (0) 3 7845 4800

 kenton.peh@boschrexroth.com.sg

South Africa - Südafrika

TECTRA Automation (Pty) Ltd.
71 Watt Street, Meadowdale
Edenvale 1609

Tel.: +27 (0)11 971 94 00
Fax: +27 (0)11 971 94 40
Hotline: +27 (0)82 903 29 23
 georgv@tectra.co.za

Taiwan

Rexroth Uchida Co., Ltd.
No.17, Lane 136, Cheng Bei 1 Rd.,
Yungkang, Tainan Hsien
Taiwan, R.O.C.

Tel.: +886 (0)6 25 36 565
Fax: +886 (0)6 25 34 754
 indramat@mail.net.tw

Thailand

NC Advance Technology Co. Ltd.
59/76 Moo 9
Ramintra road 34
Tharang, Bangkhen,
Bangkok 10230
Tel.: +66 2 943 70 62
        +66 2 943 71 21
Fax: +66 2 509 23 62
 sonkawin@hotmail.com

mailto:alexis.siu@boschrexroth.com.hk
mailto:hockhwa@hotmail.com
mailto:sonkawin@hotmail.com
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Nordamerika – North America
USA
Hauptniederlassung - Headquarters

Bosch Rexroth Corporation
Rexroth Indramat Division
5150 Prairie Stone Parkway
Hoffman Estates, IL 60192-3707

Tel.: +1 847 6 45 36 00
Fax: +1 847 6 45 62 01
servicebrc@boschrexroth-us.com
 repairbrc@boschrexroth-us.com

USA Central Region - Mitte

Bosch Rexroth Corporation
Rexroth Indramat Division
Central Region Technical Center
1701 Harmon Road
Auburn Hills, MI 48326

Tel.: +1 248 3 93 33 30
Fax: +1 248 3 93 29 06

USA Southeast Region - Südwest

Bosch Rexroth Corporation
Rexroth Indramat Division
Southeastern Technical Center
3625 Swiftwater Park Drive
Suwanee, Georgia 30124
Tel.: +1 770 9 32 32 00
Fax: +1 770 9 32 19 03

USA SERVICE-HOTLINE

- 7 days x 24hrs -

+1-800-860-1055

USA East Region –Ost

Bosch Rexroth Corporation
Rexroth Indramat Division
Charlotte Regional  Sales Office
14001 South Lakes Drive
Charlotte, North Carolina 28273

Tel.: +1 704 5 83 97 62
+1 704 5 83 14 86

USA Northeast Region – Nordost

Bosch Rexroth Corporation
Rexroth Indramat Division
Northeastern Technical Center
99 Rainbow Road
East Granby, Connecticut 06026

Tel.: +1 860 8 44 83 77
Fax: +1 860 8 44 85 95

USA West Region – West

Bosch Rexroth Corporation
7901 Stoneridge Drive, Suite 220
Pleasant Hill, California 94588

Tel.: +1 925 227 10 84
Fax: +1 925 227 10 81

Canada East - Kanada Ost

Bosch Rexroth Canada Corporation
Burlington Division
3426 Mainway Drive
Burlington, Ontario
Canada L7M 1A8

Tel.: +1 905 335 55 11
Fax: +1 905 335-41 84
 michael.moro@boschrexroth.ca

Canada West - Kanada West

Bosch Rexroth Canada Corporation
5345 Goring St.
Burnaby, British Columbia
Canada V7J 1R1

Tel. +1 604   205-5777
Fax +1 604   205-6944
 david.gunby@boschrexroth.ca

Mexico

Bosch Rexroth S.A. de C.V.
Calle Neptuno 72
Unidad Ind. Vallejo
07700 Mexico, D.F.

Tel.: +52 5 754 17 11
+52 5 754 36 84
+52 5 754 12 60

Fax: +52 5 754 50 73
+52 5 752 59 43

Mexico

Bosch Rexroth S.A. de C.V.
Calle Argentina No 3913
Fracc. las Torres
64930 Monterey, N.L.

Tel.: +52 8 333 88 34...36
+52 8 349 80 91...93

Fax: +52 8 346 78 71
mario.quiroga@boschrexroth.com.mx

Südamerika –  South America
Argentina - Argentinien

Bosch Rexroth S.A.I.C.
"The Drive & Control Company"
Acassusso 48 41/47
1605 Munro
Prov. Buenos Aires

Tel.: +54 (0)11 4756 01 40
Fax: +54 (0)11 4756 01 36
victor.jabif@boschrexroth.com.ar

Argentina - Argentinien

NAKASE
Servicio Tecnico CNC
Calle 49, No. 5764/66
1653 Villa Balester
Prov. - Buenos Aires

Tel.: +54 (0) 11 4768 36 43
Fax: +54 (0) 11 4768 24 13
 nakase@usa.net
 nakase@nakase.com
 gerencia@nakase.com (Service)

Brazil - Brasilien

Bosch Rexroth Ltda.
Av. Tégula, 888
Ponte Alta, Atibaia SP
CEP 12942-440

Tel.: +55 (0)11  4414 56 92
+55 (0)11  4414 56 84

Fax sales: +55 (0)11  4414 57 07
Fax serv.: +55 (0)11  4414 56 86
 alexandre.wittwer@rexroth.com.br

Brazil - Brasilien

Bosch Rexroth  Ltda.
R. Dr.Humberto Pinheiro Vieira, 100
Distrito Industrial    [Caixa Postal 1273]
89220-390 Joinville - SC

Tel./Fax: +55 (0)47 473 58 33
Mobil: +55 (0)47 9974 6645
 prochnow@zaz.com.br

Columbia - Kolumbien

Reflutec de Colombia Ltda.
Calle 37 No. 22-31
Santafé de Bogotá, D.C.
Colombia

Tel.: +57 1 368 82 67
+57 1 368 02 59

Fax: +57 1 268 97 37
reflutec@neutel.com.co

mailto:dave.gunby@basic.ca
mailto:dave.gunby@basic.ca
mailto:dave.gunby@basic.ca
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